kaula

MENTOR

Programacion en Android

¥ 80

e

‘ )
g, VO
gy
&,

e

oy
8

AULA

MENTOR

educacion.es



ISBN: 978-84-369-5431-9
Nipo:030-12-332-2

Autor:
Clodoaldo Robledo Sacristan
David Robledo Fernandez

Edicion y maquetacion de contenidos:

Susana Pérez Marin

Diseno grafico e ilustracion de portada:
Maria Guija Medina



INTRODUCCION

INDICE

1.1 INTRODUCCION .........coorrrrrrerrrrenressaseasssnssssssssssssssssanes 3
1.1.1 QuUEé €S ANArOid ......oveeiiiiieieeeee e 3
1.1.2 Proyecto libre (Open Source).........cccceeevecvrereecesiereeeenen, 3
1.1.3 SU IStOria@ ..ceeieieeee e 3
1.1.4 Inconvenientes de Android..........ccocoooeveiieiiinnienenenn, 4

1.2 QUE ES ECLIPSE ......c.cecovunrerenennerensensessessssssssssssssssssssnes 5
1.2.1 ElI CoNnsorcio EClPSE ....cccecveevieieeieiseeeeseeee e 5
1.2.2 Instalacién de Java Developmente Kit (JDK)................ 6
1.2.3 Instalacion de EClPSe ......cccocvvveveenieeieieeeeeeeeee 7
1.2.4 Instalacién de las librerias de Android..........cccccoveuenene 9
1.2.5 Anadir versiones y componentes de Android ............ 19

1.2.6 Definicion del dispositivo virtual de Android .............. 25



&aula

MENTOR




Introduccion

1.1 INTRODUCCION

1.1.1 Qué es Android

Android es un sistema operativo, inicialmente disefiado para teléfonos moviles como

los sistemas operativos iOS (Apple), Symbian (Nokia) y Blackberry OS.

En la actualidad, este sistema operativo se instala no s6lo en moviles, sino también en
multiples dispositivos, como tabletas, GPS, televisores, discos duros multimedia, mini

ordenadores, etcétera. Incluso se ha instalado en microondas y lavadoras.

Esta basado en Linux, que es un nucleo de sistema operativo libre, gratuito y
multiplataforma.

Este sistema operativo permite programar aplicaciones empleando una variaciéon de
Java llamada Dalvik, y proporciona todas las interfaces necesarias para desarrollar facilmente
aplicaciones que acceden a las funciones del teléfono (como el GPS, las llamadas, la agenda,

etcétera) utilizando el lenguaje de programacion Java.

Su sencillez principalmente, junto a la existencia de herramientas de programacién
gratuitas, es la causa de que existan cientos de miles de aplicaciones disponibles, que

extienden la funcionalidad de los dispositivos y mejoran la experiencia del usuario.

1.1.2 Proyecto libre (Open Source)

Una de las caracteristicas mas importantes de este sistema operativo reside en que es
completamente libre. Es decir, ni para programar en este sistema ni para incluirlo en un
teléfono hay que pagar nada. Por esta razon, es muy popular entre los fabricantes de teléfonos

y desarrolladores, ya que los costes para lanzar un teléfono o una aplicacion son muy bajos.

Cualquier programador puede descargarse el codigo fuente, inspeccionarlo,

compilarlo e incluso modificarlo.

1.1.83 Su historia

Android era un sistema operativo para méviles practicamente desconocido hasta que

en 2005 lo comprd Google.

En noviembre de 2007 se cred la Open Handset Alliance, que agrup6é a muchos
fabricantes de teléfonos moviles, procesadores y Google. Este afio se lanzé la primera version
de Android, junto con el SDK (del inglés, Software Development Kit, que significa Kit del
desarrollo de software) para que los programadores empezaran a crear sus aplicaciones

para este sistema operativo.
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El despegue del sistema operativo fue lento porque se lanzé antes el sistema operativo
que el primer terminal moévil, aunque rapidamente se ha colocado como el sistema operativo

de moéviles mas vendido del mundo.

En febrero de 2011 se anunci6 la versién 3.0 de Android, cuyo nombre en clave es

Honeycomb, que esta optimizada para tabletas en lugar de para teléfonos méviles.

Versiones disponibles:

Las versiones de Android reciben nombre de postres en inglés. En cada version el

postre elegido empieza por una letra distinta siguiendo un orden alfabético:

Cupcake (v1.5), magdalena glaseada.

Donut (v1.6), rosquilla.

Eclair (v2.0/v2.1), pastel francés conocido en Espafia como pepito.
Froyo (v2.2), (abreviatura de «frozen yogurt») yogur helado.
Gingerbread (v2.3), pan de jengibre.

Honeycomb (v3.0/v3.1), panal.

IceCream Sandwich (4.0), sandwich de helado.

Jelly Bean (¢,¢,77), gomitas de gelatina)

C=IOMmMOO

En el siguiente enlace puedes encontrar una descripcién de la funcionalidad que

incluye cada version de Android.

1.1.4 Inconvenientes de Android

Android ha sido criticado muchas veces por la fragmentacién que sufren sus
terminales (con versiones distintas de Android), ya que las actualizaciones no se despliegan
automaticamente en estos terminales una vez que Google lanza una nueva versién. Cada
fabricante debe crear su propia versiéon. Sin embargo, esa situacion cambiara ya que los
fabricantes se han comprometido a aplicar actualizaciones al menos durante los 18 meses

siguientes desde que empiezan a vender un terminal en el mercado.

Ademas, actualmente Google tiene la intencidn de unificar la funcionalidad entre las

versiones del sistema operativo para tabletas y moéviles en la version 4.0.

Disponer del cédigo fuente del sistema operativo no significa que se pueda tener
siempre la ultima version de Android en un determinado mévil, ya que el cédigo para soportar
el hardware de cada fabricante normalmente no es publico; asi que faltaria un trozo basico del

firmware (controladores) para poder hacerlo funcionar en dicho terminal.

Hay que tener en cuenta que las nuevas versiones de Android suelen requerir mas
recursos, por lo que, en los modelos mas antiguos, no se puede instalar la ultima versién por

insuficiente memoria RAM, velocidad de procesador, etcétera.


http://es.wikipedia.org/wiki/Android
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1.2 QUE ES ECLIPSE

Eclipse es un entorno de software multi-lenguaje de
programacion que incluye un entorno de desarrollo integrado (IDE).

Inicialmente, se disefid pensando principalmente en el lenguaje de

programacion Java y se puede utilizar para desarrollar aplicaciones en

este lenguaje.

En la web oficial de Eclipse (www.eclipse.org), se define como “An IDE for everything

and nothing in particular” (un IDE para todo y para nada en particular). Eclipse es, en realidad,
un armazén (workbench) sobre el que se pueden instalar herramientas de desarrollo para
cualquier lenguaje, mediante la implementacién de los plugins adecuados. El término plugin
procede del inglés to plug, que significa enchufar. Es un software que permite cambiar,

mejorar o agregar funcionalidades.

La arquitectura de plugins de Eclipse permite, ademas de integrar diversos lenguajes
sobre un mismo IDE, introducir otras aplicaciones accesorias que pueden resultar Utiles
durante el proceso de desarrollo, tales como herramientas UML (modelado de objetos),

editores visuales de interfaces, ayuda en linea para librerias, etcétera.

Usando distintas librerias es posible servirse de este entorno de desarrollo para otros
lenguajes de programacién, como Ada, C, C + +, COBOL, Perl, Delphi, PHP, Python, R. Ruby,

Scala, Clojure y Scheme.

A menudo el IDE Eclipse afiade un apellido a su nombre cuando se usa para
programar otro lenguaje. Por ejemplo, se llama Eclipse ADT (Ada Development Toolkit) para

Ada, Eclipse CDT para C/ C + +, Eclipse JDT para Java y Eclipse PDT para PHP.

Esta lista de lenguajes aumenta con los afios, ya que este IDE se esta convirtiendo en

el entorno de desarrollo de muchos programadores por su simplicidad y facilidad de uso.

1.2.1 El Consorcio Eclipse

En su origen, el Proyecto Eclipse era un proyecto de desarrollo OpenSource,
desarrollado y mantenido en su totalidad por IBM. Bajo la direccion de IBM, se fundé el
Consorcio Eclipse, al cual se unieron algunas empresas importantes como Rational, HP o

Borland.

Desde el afio 2004, el Consorcio Eclipse es independiente de IBM y entre otras
empresas, estd integrado por HP, QNX, IBM, Intel, SAP, Fuijitsu, Hitachi, Novell, Oracle, Palm,

Ericsson y RedHat, ademas de por algunas universidades e institutos tecnolégicos.
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1.2.2 Instalacién de Java Developmente Kit (JDK)

Es muy importante tener en cuenta que, para poder ejecutar el entorno de desarrollo
Eclipse y las librerias de Android, es necesario tener instaladas en el ordenador las librerias de
desarrollo de Java. Aunque ya esta disponible la versién 1.7, para poder compilar
aplicaciones Android, es necesario instalar la version 6 de Java (también conocida como
Java 1.6).

Podemos descargar la versién correcta del JDK de Java en:

http://java.sun.com/javase/downloads

Overview Downloads Documentation Community | Technologies | Training

Java SE Downloads

Latest Release Next Release [Early Access) Real-Time Previous

Java Platform {JDK} JDK + NetBeans Bundle JDK + Java EE Bundle

Here are the Java SE downloads in detail:

Java SE 6 Update 29 JDK JRE
This release includes many security fixes. Learn
mare - -
JDK 6 Docs JRE 6 Docs
= Installation = Installation
Instructions Instructions
* ReadMe  ReadMe

FeleaszeMotes ReleaseMotes

Oracle License Oracle License

= Java SE = Jlava SE
Products Products

= Third Party » Third Party
Licenses Licenses

Cerified System Cerified System
Configurations Configurations



http://java.sun.com/javase/downloads
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Java SE Development Kit & Update 26

Product | File Description File Size Download

Linux x86 - RPM Installer 76.93MB # jdk-6u26-linux-i586-rpm.bin
Linux 86 - Self Extracting Installer 8120 MB # jdk-6u26linux-i586.hin
Linux Intel ltanium - RPM Installer G025 MB # jdk-6u26-linux-ia64-rpm.bin
Linux Intel ltanium - Self Extracting Installer 67.92 MB ¥ jdk-6u26-linux-ia64.bin
Linux x64 - RPM Installer 77.15MB # jdk-6u26-linux-x64-rpm.bin
Linux x64 - Self Extracting Installer 8145 MB # jdk-fu26-linux-x64.bin
Solaris x86 - Self Extracting Binary 81.08 MB # jdk-6u26-solaris-i586.sh
Solaris ¥86 - Packages - tarZ 136.89 MB ¥ jdk-6u?6-solaris-i586.tar.Z
Solaris SPARC - Self Extracting Binary 86.05 MB ¥ jdk-6u26-solaris-sparc.sh
Solaris SPARC - Packages -tarZ 14137MB & jidk-Bu26-solaris-sparc.tar.Z
Solaris SPARC G64-bit - Self Extracting Binary 1224MB #® jdk-Bu26-solaris-sparcv9.sh
Solaris SPARC G64-bit- Packages -tarZ 15.58 MB ¥ jdk-6u26-solaris-sparcv9.tar.7
Solaris x64 - Self Extracting Binary 850 MB ¥ jdk-6u26-solaris-x64.sh
Solaris x64 - Packages - tar.Z 1224 MB ¥ jdk-6u26-solaris-x64.tar.Z
Windows x86 76.81 MB # jdk-6u26-windows-i586.exe
Windows Intel fanium 6232 MB ¥ jdk-6u26.windows-iab4.exe
Windows x64 67.42 MB ¥ jdk-6u26.windows-x64.exe

Nota: en el caso de Linux o Mac, es posible también instalar Java usando los

programas habituales del sistema operativo que permiten la actualizacién de paquetes.

Nota: si vas a instalar Eclipse y las librerias de Android en Linux, lee las notas que se

encuentran en “Preguntas y Respuestas” de esta Introduccion en la mesa del curso.

1.2.3 Instalacion de Eclipse
La instalacién es muy sencilla. Simplemente accedemos a la pagina web:

http://www.eclipse.org/downloads/

En esta pagina seleccionamos el tipo de Sistema Operativo donde vamos a instalar

Eclipse y descargamos el archivo "Eclipse Classic 3.7".

Home Downloads Users Members Committers Resources Projects  About Us

Packages Projects Indigo Torrents

Compare Packages Older Versions Eclipse Indigo (3.7) Packagesfur

Looking for the Eclipse for PHP Developers Package? More Info

Eclipse for Testers, a6 MB Windows 32 Bit
Downloaded 331 Times Details Windows 64 Bit
. Eclipse Classic 3.7, 174 mB Windows 32 Bit
Downloaded 22,764 Times Details Other Downloads Windows 64 Bit


http://www.eclipse.org/downloads/
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Hay que tener en cuenta que debemos descargar la version 32 bits o 64 bits en funcién
del sistema operativo de que dispongamos.

En el caso de Windows podemos ver el tipo de sistema operativo haciendo clic con el
botén derecho del ratén en el icono "Equipo” o Mi PC del Escritorio y haciendo clic de nuevo

en "Propiedades":

Ver informacion basica acerca del equipo

Edicion de Windows
Windows 7 Home Premium
Copyright @ 2009 Microsoft Corporation. Reservados todos los derechos.

Service Pack 1
Obtener mas caracteristicas con una nueva edicion de Windows 7

Sistema
Evaluacion: m Evaluacion de la experiencia en Windows
Procesador: Intel(R) Core(TM)2 Quad CPU Q6600 @ 240GHz 2.39 GHz
Memoaoria instalada (RAM): 6,00 GB
Tipo de sistema: Sistema operativo de 64 bits —
Lapiz y entrada tactil: Entrada manuscrita disponible

En el caso de Linux, desde la linea de comandos podemos ejecutar el siguiente

comando para saber si el sistema operativo es de 64bits:

$ uname -m

x86_64

En el caso de Apple Mac, utiliza el Perfil de Sistema para determinar si estas utilizando

un kernel de 64 bits.

1. En el menu Apple (ﬂ), selecciona Acerca de este Mac y a continuacion, haz clic en

"Mas informacién":
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SO0 About This Mac

Mac OS

Varsion 10.

5.3

Processor 2.4 CHz Intel Core 2 Duo
Memory 4 GBE5T MHz DDR2 SDRAM
Startup Disk Macintosh HD

( wore o

2. En el panel "Contenido", selecciona "Software".

3. Si Extensiones y kernel de 64 bits esta configurada como Si, estas utilizando un kernel
de 64 bits.

Cuando hayamos descargado el fichero correspondiente, lo copiamos a un directorio

o carpeta del ordenador y descomprimimos este fichero.

Es recomendable usar un directorio sencillo que podamos recordar facilmente, por
ejemplo C:\cursos_Mentor\eclipse. Ademas, es muy importante que los nombres de los
directorios no contengan espacios, pues Eclipse puede mostrar errores y no funcionar

correctamente.

Una vez descomprimido el fichero, Eclipse esta listo para ser utilizado; no es necesario

hacer ninguna operacién adicional.

Recomendamos hacer un acceso directo en el Escritorio del ordenador para arrancar

rapidamente el entorno de programacion Eclipse.

Equipo

1.2.4 Instalacion de las librerias de Android

A continuacién, debemos instalar el Paquete de Desarrollo de iniciacion (en inglés,
SDK Starter Package) de Android. Este paquete no incluye las librerias de desarrollo
completas, sino que unicamente es el nucleo del SDK que se utiliza para descargar el resto de

los componentes SDK, como la ultima plataforma Android.
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Para descargar el fichero necesario, accedemos a la pagina de descarga del SDK de

Android y nos bajamos la version que corresponda en funcion del sistema operativo donde
vayamos a instalarlo. Recomendamos que hay que descargar el archivo .zip, ya que con éste

la instalacion es mas sencilla y rapida:

Download the Android SDK

Welcome Developers! If you are new to the Android SDK, please read the steps below, for an overview of how to set up the SDK.

If you're already using the Android SDK, you should update to the latest tools or platform using the Android SDK and AVD Manager, rath
See Adding SDK Components.

Windows android-sdk_r12-windows zip 36486190 bytes  8d6c104a34cd2577c5506c55d981achf D

installer r12-windows.exe (Recommended) 36531492 bytes 367fled4decd70aefc290d1f7dchb578ab

Mac OS5 X (intel) android-sdk_r12-mac_x86 zip 30231118 bytes  341544e4572b4db1afab123ab817086e7
Linux (i386) android-sdk_r12-linux_x&6 tgz 30034243 bytes  f5485275a8dee3d1929936ed5382e9%3

Cuando hayas descargado la versidén .zip o .tgz, descomprimelo en el disco duro.

Recomendamos que conviene usar el directorio C:\cursos_Mentor\Android\android-sdk-

windows.

Si usas otro directorio, toma nota del mismo, ya que, mas adelante, tendras que usar

el nombre de este directorio para acabar de configurar el plugin de Android en Eclipse.

Ahora vamos a instalar las librerias necesarias en Eclipse. Estas librerias se denominan
Android Development Tools (ADT). Para ello, arrancamos Eclipse haciendo doble clic sobre
el acceso directo que hemos creado anteriormente. A continuacion, Eclipse pedira que

seleccionemos el "workspace", es decir, el directorio donde queremos guardar los proyectos.

Select a workspace

Eclipse SDK stores your projects in a folder called a workspace,
Choose a workspace folder to use for this session,

VLI ETR C cursos_MentoriAndroid)y - Browse...

[T] Use this as the default and de not ask again

[ ok || Conce



http://developer.android.com/sdk/index.html
http://developer.android.com/sdk/index.html
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Seleccionaremos un directorio sencillo y facil de recordar.

Importante: Recomendamos usar el directorio C:\cursos_Mentor\Android\proyectos como
carpeta personal

Finalmente hacemos clic en OK para abrir Eclipse:

File E Run Navigate Search Project Refactor Window Help

% Welcome & B FAE-#)
.
7 Workbench

Welcome to Eclipse

€ Overview Tutorials
Get an overview of the features B 6o through tutorials
@<, Samples /\_ What's New
~ Try out the samples v Find out what is new

Ahora vamos a configurar las preferencias de la version de Java en Eclipse para
compilar los proyectos de Android. Para ello, hacemos clic en la opcién del menu “Window->

Preferences...”, hacemos clic en el panel izquierdo sobre “Java->Installed JREs” y

seleccionamos “jre6” en el campo “Installed JREs”:

« Preferences L@g
type filter text Insthlled JREs Co e
General o l L . .
. = Add) remove or edit JRE definitions. By default, the checked JRE is added to the build path of
Android newfy created Java projects.
Ant
CSS Files Instglled JREs:
Google Name Location Type Add... r—
Help [ITI =ijre6  C\Program Files\Java\jre6 Standard VM
Install/Update = - . : ) Edit...
= [T=hjre7  C\Program Files\Javayjre7 Standard VM
Appearance
Build Path
Code Style
Compiler L
Debug
Editor
Installed JREs
Junit
Properties Files +
< 111 »
@ [ oK I ’ Cancel ]

Si no podemos seleccionar "jre6" debemos usar el botén "Add" para anadir las
librerias del JRE 6. Por ejemplo, en Windows, se pueden encontrar en el directorio:

"C:\Program Files\Java\jre6".
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Para finalizar, en esta ventana hay que seleccionar la version de Java utilizada para

compilar los proyectos de Android. Para ello hacemos clic en “Java->Compiler” y elegimos

“1.6” en el campo “Compiler compliance settings”:

Si no hemos seleccionado la version 6 de

= Preferences

pe filter texi]

General

Android

Ant

CSSFiles

Google

Help

Install/Update

Java
Appearance
Build Path
Code Coverage
Code Style
Compiler
Debug
Editor
Installed JREs
JUnit
Properties Files Edi

JavaScript

Maven

Plug-in Development

Compiler

JDK Compliance o

Compiler compliance level:

Use default compliance settings

Generated class files compatibility: 16 -
Source compatibility: 16 -
Disallowe identifiers called ‘assert” Error -
Disallowe identifiers called ‘enum’: Error -

Classfile Generation
Add variable attributes to generated class files (used by the debugger)
Add line number attributes to generated class files (used by the debugger)
Add source file name to generated class file (used by the debugger)
Preserve unused (never read) local variables

Inline finally blocks (larger class files, but improved perfermance)

Run/Debug

Team

WindowBuilder
. l%l . IRestmre Defaults] [ Apply l
@ [ 0K ] I Cancel }

siguiente mensaje de error en Eclipse:

= Preferences

type filter text

> General
> Android
> Ant
> CSS Files
> Google
> Help
» Install/Update
4 Java
» Appearance
> Build Path
Code Coverage
» Code Style
»|Compiler
» Debug
» Editor
» Installed JREs
JUnit
Properties Files Edi
» JavaScript
> Maven
> Plug-in Development

Compiler

Configure Project Specific Settings...

JDK Compliance
Compiler compliance level:

Use default compliance settings

Generated .class files compatibility: 1.6 -
Source compatibility: 1.6 -
Disallow identifiers called ‘assert’: Error A
Disallow identifiers called ‘enum’: Error -

Classfile Generation

Add variable attributes to generated class files (used by the debuager)
Add line number attributes to generated class files (used by the debugger)
Add source file name to generated class file (used by the debugger)
Preserve unused (never read) local variables

Inline finally blocks (larger class files, but improved performance)

& When selecting 1.6 compliance, make sure to have a compatible JRE installed
and activated (currently 1.7). Configure...

Configure Project Specific Settings.. /

JRE en el paso anterior aparecera el
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Importante: Es necesario disponer de conexién a Internet para poder continuar con los
siguientes pasos y poder descargar las librerias necesarias.

A continuacién, seleccionamos en el menu Help -> Install New Software...

En el cuadro de dialogo que aparecera, introducimos la direccion del sitio de descarga
de las librerias ADT:

https://dl-ssl.google.com/android/eclipse/

Y pulsamos la tecla Intro. A continuacién, marcamos todas las opciones tal y como se
muestra en la siguiente captura de pantalla:

Es muy Importante comprobar la versién de Java. Si no, no se instalara bien el software de
Android.

el s > ____un T )

Available Software .
Check the items that you wish to install, \9‘—

Work with:  https://dl-ssl.geogle.com/andreid/eclipse/

Find more software by working with the "Available Software Sites” preferences,

type filter text
Mame Version
a []000 Developer Tools
[7] 4 Android DDMS 12.0.0.v201106281929-138431
Lt Android Development Tools 12.0.0.v201106281929-138431
-rﬁ Android Hierarchy Viewer 12,0.0,201106281929-138431
'-?]_?: Android Traceview 12.0.0201106281929-138431
Select All | | Deselect All 4 items selected
Details
Android Dalvik Debug Monitor Service
[¥] Show only the |atest versions of available software [ Hide items that are already installed
[¥] Group items by category What is already installed?

["] Show enly software applicable to target environment

[#] Contact all update sites during install to find required software

® < Back Mesxt » FEinish

oty

- N

N
13 c‘{‘v\

i,


https://dl-ssl.google.com/android/eclipse/
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Hacemos clic en el botén "Next".

Nota: este proceso puede llevar un rato en funcién de la conexién a Internet y de

potencia del ordenador que tengamos.

Después, aparecera la siguiente ventana:

'alnslzll-

Install Details
Review the items to be installed. (p
Name Version Id
@ Android DDMS 12,00,:2011062819... com.android.ide.eclipseddms.feature.gro..
{4t Android Development Tools 12.0.0,2011062819... «com.android.ide.eclipse.adt.feature.group
Lt Android Hierarchy Viewer 12.0.0,2011062819... com.android.ide.eclipse.hierarchyviewerf...
@ Android Traceview 12,0.0,:2011062819... com.android.ide.eclipsetraceview feature...,
Size: Unknown
Details
@ <Back || Nea> 1| Fnsh |[ Cancel

Hacemos clic de nuevo en "Next", seleccionamos "l accept...

licencia y hacemos clic en "Finish":

a

" en el acuerdo de

Review Licenses

Licenses must be reviewed and accepted before the software can be installed. (g

Licenses:

License text:

|- Apache License

4 e

. Mote: jeommen-1.012jar is under the BSD license rather than the AF
MNote: kemnl2-2.3.0,jar is under the BSD license rather than the EPL. ¢

Apache License
Version 2.0, January 2004
http://www.apache.org/licenses/

TERMS AND COMDITIOMS FOR USE,
REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License” shall mean the terms and conditions for
use, reproduction,

@ { accept the terms of the license agreements:

(7)1 do not accept the terms of the license agreements

-

Finish ||  Cancel
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A continuacién, se instalara el software necesario de Android:

by v S
@ Installing Software

Fetching com.android.ide.eclipse.adt_12.0.0....//dl-ssl.google.com,/android/eclipse/plugins/

[C] Always run in background

Installing Software
B - | ®
Installing Software: Fetching com.andro...sl.geogle.com/android/eclipse/plugins/

Run in Eackgroundl [ Cancel ] I << Details I

Se mostrard este aviso de seguridad y pulsaremos en "OK" para continuar la

instalacion:

# Warning: You are installing software that contains unsigned content. The authenticity or
validity of this software cannot be established. Do you want to continue with the

installation?

|| Details >>

Al acabar la instalacién, es necesario reiniciar Eclipse. Para ello haremos clic en
"Restart":

Software Updates

You will need to restart Eclipse SDK for the installation changes to take effect. You may try
to apply the changes without restarting, but this may cause errors.

Restart Now | [ Not Now ] [gpply Changes Now
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Al arrancar de nuevo Eclipse ya dispondremos de las

empezar a trabajar con Android:

librerias necesarias para

Welcome to Eclipse

Q Overview @
Get an overview of the features

04 » Samples ‘,.-’\\
W Try outthe samples S

Tutorials

Go through tuterials

What's New

Find out what is new

Workbench

Podemos hacer clic en la X de la pestana "Welcome" para acceder al entorno de

desarrollo:

File Edit Source Refactor Navigate Search Project Run Window Help

[ = Java - Eclipse SC gci |

O-HRE @-®dh $-0 Q- H#Gv &y Hrilve o o @ ma)
i pacge bplorer L = 5| outine 5=
BES~ An outline is not available.

[ Problems 2 @ Javadoc] B Declaration} v =5
0 items
Description - Resource Path Locatic

1

x| Sign in to Google... i

La primera vez que accedemos al entorno Eclipse, aparece la siguiente ventana en la

que debemos indicar dénde hemos instalado el SDK de Android:
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& | &' Java |
9= outine 7 ) =g
Configure SDK \ Y| anoutine is not avalable.

Welcome to Android Development

To develop for Android, you need an Android SDK, and at least one version of te Android AFIs
o compile against. You may also want addiional versions of Android to test with.

(@) Install rew SOk
Instal the latest avalable version of Android APIs (supports all the latest features)
[ linstal Android 2.1, a version which is supported by ~97% phones and tablets
{(ou can add additonal pladforms using the SDK Manager.)

Target Location: | CDocuments and Setingstandroid-sdks | [Browse...}

—— () |se existing SOKS

Existing Locatlon:| | Browse..,

£ Proplems 52 @ Javadoc [ Dedclaration| e
Qitems

Hacemos clic en el boton “Browse...” e indicamos el directorio donde hemos instalado
el SDK de Android. Si has seguido las instrucciones de Windows, el directorio por
recomendado para descomprimir el archivo del SDK es

“C:\cursos_Mentor\Android\android-sdk-windows”. Pulsamos el boton “OK” para finalizar
la configuracion.

 Welcome to Android Development

Welcome to Android Development

by SDK Flatform Tools component is missing! Please use the SDK Manager to install it

To develop for Android, you need an Android S0k, and at least one wersion of the Android AFIs
to compile against. You may also want addiional versions of Android to test with.

(O Install new SO
Install the latest avalable version of Android APIs (supports &l the latest features)
[install android 2.1, a version which is supported by ~97% phenes and tablets
(ou can add additional platforms using the S0k Manager.)

Target Location: | | Browse, .,
(@) Use existing SDKs
Existing Location: | Ch\cursos_Mentoriandroidiandroid-sdk -windows | ’Browse... ]

@

A continuacién, aparece otra ventana solicitando nuestra conformidad para enviar

estadisticas de uso del SDK de Android. No es necesario hacerlo si no lo deseamos:

-
=N

\ 1 7. c‘{‘v‘\

i,
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£ Welcome to Android Development |__ B
Contribute Usage Statistics? f \
We know you just want to get started but please read this first,
By choosing to send certain usage statistics to Google, wou can help us improwve the Android
SOk, These usage statistics lets us measure things like active usage of the SDK, and let Ls know
things like which wversions of the SDK are in use and which tools are the most popular with
developers, This imited data is not associated with personal information about you, and is

examined on an aggregate basis, and is maintained in accordance with the Google Privacy
Folicy.

Send usage statistics to Google?
(ves
O}

If you later decide to change this setting, vou can do so in the"ddms" tool under "File" =
"Preferences" = "Usage Stats",

Google Privacy Policy

@j Eirist l [ Cancel

Pulsamos el botdn “Finish” para finalizar la configuracion. A continuacion, aparece el
siguiente mensaje indicando que no hemos instalado ninguna versién del sistema operativo
Android:

~ Android SDK Verification

SOk Flatform Tools component is missing!
£ ) Please Use the SDK Manager to install it

Pulsamos el boton “OK”, en el siguiente paso, instalamos la version de Android sobre

la que vamos a trabajar en este curso.

En el caso de que no aparezca la ventana que permite indicar a Eclipse dénde se
encuentra el SDK de Android, podemos hacerlo manualmente. Para ello, hacemos clic en la
opcién del mend “Window-> Preferences...” vy seleccionamos “Android” en el panel

izquierdo:
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# = Preferences N Em

type filter text
> General
> | Android
- Ant
55 Files
- Google
> Help
> Install/Update
Java

= Javabcript

- Maven

> Plug-in Development
Run/Debug

> Team

» XML

@

Android

Android Preferences

SDK Location:  C:\cursos_Mentor\Android\android-sdk-windows

G Do

Mote: The list of 5DK Targets below is only reloaded once you hit "Apply' or 'OK.

-

Target Mame Vendor Platform  API...
Android 233 Android Open Source Project 233 10
Google APls Google Inc, 233 10
[Re:tore Defaults] ’ Apply
[ OK l ’ Cancel ]

Para acabar, pulsamos el botén “OK”.

1.2.5 Anadir versiones y componentes de Android

El dultimo paso en la configuracién de las librerias de Android es descargar e instalar

los componentes esenciales del SDK para el entorno de desarrollo.

El SDK utiliza una estructura modular que separa las distintas versiones de Android,

complementos, herramientas, ejemplos y la documentacién en un Unico paquete que se puede

instalar por separado. Para desarrollar una aplicacion en Android, es necesario descargar, al

menos, una version. En este curso vamos a usar la version 2.3, por ser la mas extendida en

el momento de redaccién de la documentacién. No obstante, vamos a emplear sentencias

compatibles y recompilables en otras versiones.

Para anadir esta version hay que hacer clic en la opcion “Android SDK Manager” del

menu principal “Window” de Eclipse:

19
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Search  Project IEndnw Help

ng @ # - New Window raR
%\ | New Editor —

<] Open Perspective v ||
M Show View ,

Customize Perspective...
Save Perspective As...
Reset Perspective...
Close Perspective

Close All Perspectives

MNavigation 3
Android SDK Manager <———
E AVD Manager

Preferences

Se abrird la ventana siguiente:

- —
i = N W, _w |

Rk Ok

| SDK Path: C:\cursos_MentoriAndroid\android-sdk-windows\,

Packages
H Name API Rev.  Status
[ Tools|
[] X Android 5DK Tools 15 &Installed
[C] i Android SDK Platform-tools ¥ Not installed
4 [7]12) Android 4.0 (APT14)
Documentation for Android SDK 14 ¥ Mot installed
" SDK Platform 14 B Not installed
& Samples for SDK 14 ¥ Not installed
% ARM EABI v7a System Image 14 ¥ Not installed
i Google APIs by Google Inc. 14 ¥ Not installed
. [F]12 Android 3.2 (AP113)
» [ Android 3.1 (AP112)
b [7]LE] Android 3.0 (API11)
& [0 Android 2.3.3 (API10)
| | &[]0 Android 2.2 (APIS)
¢ [ Android 21 (APIT)
b [C]LE Android 1.6 (AP14)
& [F]1E) Android 1.5 (AP13)
a [0 Extras
[7] 88 Android Support package ¥ Mot installed
[] 8 Google Admob Ads Sdk package ; Mot installed
&} Google Market Billing package ’ Mot installed
|| B8l Google Market Licensing package ¥ Not installed
@ Google USB Driver package $ Not installed
[] B8 Google Webdriver package ¥ Not installed
Show: Updates/New [|Installed Obsolete  Select New or Updates l Install 6 packages..,
Sort by: @ APl level () Repository Deselect All | Delete packages...

|a
| Done loading packages.

Para instalar la version 2.3.3, seleccionamos los paquetes que se muestran en la

siguiente ventana:

O
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Android SDK Manager S e

Packages Tools

SDK Path: C:\cursos_Mentor\Android\android-sdk-windows),

Packages
MName APL Rev.  Status
4 [ | Tools|
[ X Android SDK Tools 15 Shlnstalled
—_—]> [7] i Android SDK Platform-tools & Mot installed

i+ [C] £l Android 4.0 (AP114)

L] Android 3.2 (API13)
Android 3.1 (API12)
Android 3.0 (API11)
|2l Android 2.3.3 (AP110)

ey 7] ‘' SDK Platform 10 & Not installed
——)  [7] & Samples for SDK 10 ¥ Not installed
[T g Dual Screen APls by KYOCERA Corporation 10 & Not installed
[7] g EDK 1.1 by Sony Ericsson Mobile Communications 10 ¥ Mot installed

' Google APIs by Google Inc. 10 -+ Not installed
Android 2.2 (API8)
Android 2.1 (APIT)
| Android 1.6 (APT4)
=] Android 1.5 (API3)

| Extras
el (7] Gl Android Support package & Mot installed
[T] B Google Admob Ads Sdk package ¥ Mot installed
[C] 88 Google Market Billing package -+ Not installed
[] @ Google Market Licensing package ¥ Not installed
) (7] (B8] Google USB Driver package & Not installed
[] &l Google Webdriver package + Not installed
Show: [V]Updates/New [V|Installed  [T] Obsolete Select New or Updates Install 6 packages
Sort by: @ API level () Repository Deselect All Delete packages..

Done loading packages.

Nota: la revisién de las versiones de Android puede ser superior cuando al alumno o

alumna instale el SDK.

Una vez hemos pulsado el boton “Install 6 packages”, aparece esta ventana y

seleccionamos la opcion “Accept All” y, después, hacemos clic en “Install”:

- - - (= 3 1
Choose Packages to Install =

Packages Package Description & License
" Android SDK Platform-tools, revision 2 [*] Package Description -
* SDK Platform Android 2.3.3, API10, revisio... | Android SDK Platform-tools, revision 9 I
~" Samples for SDK API10, revision 1 Dependenci
~ Google APIs by Google Inc., Android APIL.. This package is a dependency for: A
~" Android Suppert package, revision 4 - Android SDK Tools, revision 15 i

| ~ Google USE Driver package, revision 4
Archive Description

Archive for Windows &
Size: 9.2 MiB

SHAL: 922be0210bac?1 36fcd3863 7 cE0ecd9dBEA4T5e

-

() Accept () Reject @) Accept All

[ Install ] [ Cancel

El instalador tarda un rato (10-20 minutos) en descargar e instalar los paquetes:
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B Installing Archives " S—_—_—_- X

Downleading Android SDK Platform-tools, revision 6 (20%, 461 KiB/s, 27 secom

i |

Downloading Android SDK Platform-tools, revision 6 -

Para acabar, reiniciamos el ADB (Android Debug Bridge):

i ' Installing Archives | ® |

Installing Google APIs by Google Inc., Android API10, revision 2 (99%)

Ca—

A package that depends on ADB has been updated.
W' Doyouwantto restart ADB now?

La instalacion ha finalizado correctamente:

i ' Installing Archives ‘ u

Done. 10 packages installed.

—  Close

Installed Google Market Licensing package, revision 1 *
Downleading Google Market Billing package, revision 1

Installing Google Market Billing package, revision 1

Installed Google Market Billing package, revision 1

Downleading Google APIs by Google Inc., Android APIL0, revision 2
Installing Google APIs by Google Inc., Android API10, revision 2
Installed Google APIs by Google Inc., Android API10, revision 2
Updated ADB to support the USB devices declared in the SDK add-ons.
‘adb kill-server' succeeded.

ADE: * daemon not running. starting it now on port 5037 *

‘adb start-server' succeeded.

ADB: * daemon started successfully *

m

Ahora vamos a ver la estructura que tiene el SDK de Android. Para ello, abrimos el
explorador en el directorio “C:\cursos_Mentor\Android\android-sdk-windows” o en el

directorio donde lo hayamos descomprimido. La siguiente tabla describe los subdiretorios que
contiene esta carpeta:
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NOMBRE

CARPETA

add-ons/

docs/

platform-
tools/

platforms/

<platform>/

samples/

tools/

SDK

Readme.txt

SDK
Manager .exe

DESCRIPCION

Contiene los paquetes “add-on” del SDK de Android que permiten desarrollar
aplicaciones usando librerias externas disponibles para algunos dispositivos
o terminales.

Documentaciéon completa en formato HTML, incluyendo la Guia del
desarrollador y la guia de la API. Para leer la documentacion, puedes abrir el
fichero offline.ntml en un navegador Web.

Contiene las herramientas de desarrollo comunes del SDK que se actualizan
con cada nueva versiéon de Android, tales como el ADB (Android Debug
Bridge), asi como otras herramientas que no se suelen utilizar directamente.

Contiene las versiones de Android con las que se puede desarrollar
aplicaciones en Eclipse. Cada versibn se encuentra en un directorio
independiente.

Directorio de la plataforma de la versidon correspondiente, por ejemplo,
"Android-10". Todos los directorios de la version de Android contienen un
conjunto similar de archivos y la misma estructura de subdirectorios.
Ademas, también incluye la libreria de Android (android.jar) que se utiliza
para compilar aplicaciones con esta versién de Android.

Contiene los ejemplos de cédigo para esa versidon especifica de Android.

Contiene el conjunto de herramientas de desarrollo y creacion de perfiles que
son independientes de la version de Android, como el emulador, el SDK de
Android y AVD Manager, DDMS (Dalvik Debug Monitor Server), etcétera.

Archivo que explica como realizar la configuracién inicial del SDK de Android.

Aplicacién que inicia el SDK de Android y la herramienta AVD de gestién de
paquetes. Sélo disponible en Windows.
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Finalmente, vamos a incluir el directorio donde hemos instalado las librerias de
Android en el PATH del sistema operativo. En concreto, vamos a incluir los directorios tools y

platform-tools.
Si has usado el directorio recomendado, los subdirectorios son:

C:\cursos_Mentor\Android\android-sdk-windows\tools

y
C:\cursos_Mentor\Android\android-sdk-windows\platform-tools

En Windows, se puede hacer esto accediendo al “Panel de control”, haciendo clic en
el icono “Sistema”, seleccionando la pestafia “Opciones avanzadas” y haciendo clic en el
botén “Variables de entorno”. A continuacién, afiadiremos los directorios anteriores a la

variable PATH de la siguiente ventana:

Propiedades del sistema

| Fiestaurar sistema | Actualizaciones automéaticas | Femoto | Pyuda

| General | MNombredeequipn | Hardware ‘ Opriones avanzadas
Debe iniciar la sesion como un Administradar para hacer -
cambios Variables de entorno v|Br
Fendimienta = I 4 ~
Efectos visuales, programacian del procesador, uso de| ¥arisbles de usuario para t146005 npresorasy - Intel(R ASF
wirtual faxes Agent Conscle
Warizhle Yalor
PATH Charchivos de progrdmaimap !
TEMP CA\Documents and Sditings\t1469064Ca.., dj
o —— TP Chpocuments and Sgitings\t14690e4 ... bpciones de  Dplones de
Configuracian del escritorio relacionada con su inicio de pcesibiidad carpeta
Hueva ] [ Modificar ] [ Eliminar ] x.
pciones del Panel de
Inicio v recuperacian Wariables del sistema pscodficad.. controldel..
Inicio de sistema, error de sistema e informacion de dep b el ~ ;
CLASSPATH LCihbrchivos de programadJavatjreadli.. gg ),
ComSpec CNAMNDOWShsystem32ie md.exe Sistema Software
CYEWIN ty Updates
FP_MO_HOST_C... NO
‘“ariables de entorno NUMBER_OF_PR... 2 But] o= LA
]
Huevra ] [ Modificar ] [ Eliminar ] Wined i
BNy achualizaciones autom:
Ca [ Aceptar J [ Cancelar ]

En Windows 7 se puede acceder a la ventana anterior abriendo el “Panel de control”,
haciendo clic en el icono “Sistema y Seguridad”, después en "Sistema" y, para acabar, en la
opcion "Configuracion avanzada del sistema" para acceder a la ventana anterior:

@O:Lﬁ! » Panel de control » Sistema y seguridad » Sistema
a - - =

il -

Archivo Edicién Ver Herramientas Ayuda

Ventana principal del Panel de

— Ver informacion basica acerca del eq

Edicion de Windows

"p' Administrador de dispositivos
& Configuracion de Acceso Windows 7 Home Premium
remoto Copyright © 2009 Microsoft Corporation. Re
4 Proteccion del sistema Service Pack 1
..,1 Configuracion avanzada del Obtener mas caracteristicas con una nueva e

sistema

G



Introduccion

Escribiendo el comando path en una ventana de comandos de Windows podemos ver

si se hemos modificado bien esta variable global del sistema:

C:\WINDOWS\system32\cmd. exe

C:\>PATH

PATH=C:\Archivos de programa‘\PC Connectivity Solution\;C:\Archivos de programa\B
orland\Delphi7\Bin:C:\Archivos de programa\Borland\Delphi7\Projects\Bpl\;C:\WIND
OWsS\system32;C:\WINDOWS ; C:\WINDOWS\System32\Wbem;C:\Archivos de programa\Intel\D
MIX;C:\Archivos de programa\NTRU Cryptosystems\NTRU TCG Software Stack\bin\;C:\A
rchivos de programa\Wave Systems Corp\Gemalto\Access Client\u5\;C:\Archivos de p
rograma\Intel\WiFi\bin\;C:\Archivos de programa‘\Archivos comunes\Roxio Shared\DL

LShared\;C:\Archivos de programa\Archivos comunes\Roxio Shared\9.0\DLLShared\;C:
\WINDOWS\system32\WindowsPowerShell\ul.0;C:\Archivos de programa\QuickTime\QTSys
tem\;C:\Archivos de programa\Calibre2\;C:\Archivos de programa\OpenSSH\bin;C:\Ar]
chivos de programa\Smart Projects\IsoBuster:C:\WINDOWS\system32\lWindowsPowersShel
1\v1.0;C:\Archivos de programa\Nmap;C:\cursos_MWentor\eclipse\plugins\com.google.
gut.eclipse.sdkbundle_2.3.0.r37v201106211634;C:\cursos_Mentor\Android\android-sd
k-windows\tools;C:\cursos_Mentor\Android\android-sdk-windows\platform-tools;

C:\>

Nota: en el resultado de este comando debemos ver el directorio de instalacién de
Android. Es muy importante que se muestre tal como aparece en la ventana anterior: con
punto y coma al final del directorio SDK y sin espacios entre el punto y coma del

directorio anterior.

En OS X (Mac) y Linux, puedes agregar la ruta a la variable PATH con el comando SET

o estableciendo la variable correspondiente en un script de inicio.

1.2.6 Definicion del dispositivo virtual de Android

Para poder hacer pruebas de las aplicaciones Android que desarrollemos sin
necesidad de disponer de un teléfono Android, el SDK incluye la posibilidad de definir un
Dispositivo Virtual de Android (en inglés, AVD, Android Virtual Device). Este dispositivo

emula un terminal con Android instalado.

Para definir el AVD, hacemos clic en la opciéon “Android AVD Manager” del menu principal
“Window” de Eclipse:

25
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[ Window | Help

Mew Window b’
Mew Editor —1
Open Perspective vl
Show View k

Customize Perspective...
Save Perspective As...
Reset Perspective...
Close Perspective

Close All Perspectives
Mavigation 2

Android SDK Manager
AVD Manager C——

Preferences

A G

Aparecera la siguiente ventana:

+ Android SDK and AVD Manager

List of existing Android Virtual Devices located at C:\Documents and Setingsit146306\,. androidiavd

Instaled packages
Avallable packages AVD Mame Target Mame Platform APT Lewel CPU/ABI Mew. .,

Edit...
Delete...
Repair...
Detais...

Start...

Refresh

w b ovalid Android Virtal Device, B0 A repairable Android Yirtual Device.
X An Android Yirtual Device that falled to load. Click 'Details' to see the error.

Hacemos clic en el botén “New” de la ventana anterior y la completamos como se

muestra en la siguiente ventana:
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 Create new Android Virtual Device (AVD)

Mame: cursoAndroid
Target: Android 2.3.3 - AP Lewvel 10 v
CPU/ABT:
SO Card:
@) sSize: | 25 MEB v
() File:
Snapshot;
D Enabled —
Skim:
(®) Built-in: Default (WWEAB0D) v
() Resolution: X
Hardare:
Property Walue Mewy, .,
Abstracted LCD dens... 240
Max Wi application h... 24
Device rarm size 256
Create AVD I [ Cancel

La opcién “Snapshot-> Enabled” permite guardar el estado del dispositivo de manera

que todos los cambios que hagamos, como cambiar la configuracién de Android o instalar

aplicaciones, queden guardados. Asi, la proxima vez que accedamos al emulador, se recupera

automaticamente el Ultimo estado.

Importante: En el curso hemos creado un dispositivo virtual que no guarda el estado porque
puede producir problemas de ejecucién con Eclipse. En todo caso, el alumno o alumna puede
usar la opcién “Edit” del AVD cuando crea necesario que los ultimos cambios sean

almacenados para la siguiente sesion de trabajo

Para acabar, basta con hacer clic en “Create AVD”:

27
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Android SDK and AVD Manager [l o0

List of existing Android Virtual Devices located at C:\Users\Ali y David\.android\avd

nstalled packages

Aovailable packages AVD Mame Target Name Platform APILevel (CPU/ABI Mew...

“ curscAndr.. Android 2.3.3 233 10 ARM (armea... Edit

Delete...
Repair...
Details...
Start...

En esta Introduccién puedes encontrar el video “Cémo instalar Eclipse y el plugin
Android”, que muestra de manera visual los pasos seguidos en las explicaciones anteriores
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